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WELCOME TO ISHIDÓ!

From the first move this ancient game and beautiful puzzle will call upon your deepest

powers of strategy and concentration as you match 72 stones on a board of 96

squares.

You can play a power game to amass points and compete against the clock; or play

for elegance, kicking back and meditating over each move with the deliberation of a

master. See if you can learn how to empty the pouch, and discover the secret of 4-

Ways. Let the Oracle guide you as you play against the computer or challenge your

friends.   

Design your own stonesets, backgrounds and game boards using Ishidó's sophisticated

graphics editors and/or your own paint and draw programs.

As you merge with the game's myriad possibilities, you will have a chance to discover

the heart of Ishidó,and why, to some, the Way of Stones is more than just a game.
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User Requirements

Before you start playing the Macintosh version of Ishidó, you should know how to:

• Use the icons on the Macintosh desktop.

• Open and close Macintosh documents and folders using the Finder.

• Point and select with the mouse, and understand basic Macintosh terms and 

techniques such as click, double-click, and drag.

• Scroll in a window or list box using the scroll bars and the scroll box.

• Pull down menus and choose commands.

• Use the Clipboard and find files in the hierarchical file system.

You should also understand Macintosh terms such as dialog box, list box, folder, and

button. For information on any of these items, see your Macintosh owner's guide.



Installing Ishido

To install Ishido to your hard disk, insert the CD-ROM disc into your

CD-ROM drive and double-click on the "Ishido Installer" icon.  Then

follow the instructions given in the installer.  After you install the

game to your hard disk, you won't need the CD-ROM inserted in

your CD-ROM drive anymore.

To run Ishido, double-click on the Ishido folder, then double click on the Ishido icon.

Opening, Ending, and Saving Games 

You can end, save, open saved games, start a game over, or quit Ishidó at any time.

Select the File Menu and the appropriate command:

Command Function

New Game Begins a new game.

Start Game OverStarts the current game over from the beginning.

End Game Ends the current game. (Games do notend automatically.)

Save... Saves a game in progress. At Save game as: type in the .

name you want and select Save.

Save As Saves a game under a new name. At Save game as: type 

in the name you want and select Save.

Open... Opens a list of your saved games. Find then choose 

the game you want. Then select Open or double click on 

the name of the game you want to open.

Quit Exits you to the Macintosh desktop.

9ISHIDO
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LET'S PLAY!

The first step in playing Ishidó is getting to know the board. 

Playing Board

• The Menu Bar appears when you click on the top of the screen: File, Game,

Options, Help, and High Scores. (An Edit menu appears between File and Game

whenever a desk accessory requires its use.)

• The game board is eight squares high by 12 squares wide, a total of 96 squares.

• Stones come in sets of 72 stones. Every stone has two attributes: a color  and a

symbol.  There are six symbols and six colors in each stoneset, creating 36 individual

stones. There are two of each stone (a pair of each), thus creating 72 stones in each

stoneset.
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• The Within consists of the light interior squares. 

• The Beyond consists of the dark squares lining the perimeter of the board. 

• The Touchstone displays the next stone to be played. You can place a stone on

the board two ways:  by clicking on it once, dragging it from the touchstone to the

board, and clicking it in place; or by clicking directly on the square in which you want

the stone to be placed. 

• The Scoreboard shows both the number of points scored (at the top) and the num-

ber of 4-Way matches achieved (at the bottom). 

• The Pouch shows a representation of the number of stones remaining to play.

Double-clicking on it shows you the stones in detail, in the order they will be drawn

from the pouch. 
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Playing the First Stone

Now that you're familiar with the board, it's time to cast the first stone. When the game

opens and you see the empty game board, select New Game from the File menu.

Every game begins with a new opening tableau of stones on the board, and a pouch of

randomly ordered stones. An opening tableau consists of six stones (one in each of the

four corners and two in the center squares, as shown on the playing board on page 6).

Every stone has two attributes: a symbol and a color (pattern is substituted for color

in black & white versions). All six symbols and six colors in the stoneset are represent-

ed in every opening tableau. 

At each turn, the computer draws one stone from the randomly ordered pouch and

displays it on the touchstone. You'll place each stone on the board beside a stone of

matching color or symbol. You then continue to place stones until either no more legal

matches are possible or the pouch has been emptied.

You place a stone by pointing the cursor to a desired square (must be adjacent to one

or more stones already on the board) and clicking once.  If your  move is legal the

stone on the touchstone moves automatically to the square you selected. If your  move

not legal the stone will not move and a dialog box will instruct you.

You can also move stones from the touchstone to the board by clicking once directly

on the stone and dragging it to a square on the board. Click the mouse button once

again to place the stone. This method is especially helpful when first learning to play

Ishidó, because it enables closer scrutiny and comparison of the stones' attributes.
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Matching Stones

A stone may only be placed on the board adjacent to (above or below, to the left or

right of—but not diagonal to) another stone. And it must match either the color (pattern)

or the symbol of that stone. 

To legally place a stone next to two other stones, your stone must match one stone with

the color (pattern) attribute and match the second stone with the symbol attribute.  The

same attribute cannot be used to match both stones!

To legally place your stone so that it adjoins three other stones, you must match two of

the stones with one attribute, and the third stone with the other attribute. Using the same

attribute to match all three stones is an illegal move.
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After you gain experience making two-way and three-way matches, try your skill at a

four-way match  (4-Way). To make a 4-Way, place a stone in the center of four other

stones, matching two of the stones on one attribute and the other two stones on the

other attribute. Using one attribute to match on more than two stones is not a legal

move.
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Creating a 4-Way

Creating 4-Ways is the way to build a winning strategy. It is also the only way to

receive Oracle auguries (readings). You can learn more about the oracle in the section

on Using the Oracle and pick up strategy tips in the Strategy section in this manual. For

now, here are some basics:

1. Using any chosen stone, start building a 4-Way match by placing a stone that match-

es the color [(pattern)  on one of its sides and a stone that matches its symbol on an

adjoining side.

2. Then draw other stones from the pouch and add to the 4-Way.
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3. Only this stone               can be placed in the center to complete this 4-Way

match.  If you get stuck, take your best guess at placing the next stone…dialog boxes

will pop up and help guide you if you make a mistake. (See Center Master Play and

Master Game for more insight into creating 4-Way matches.)
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Just Remember These 4 Simple Rules...

1. Each stone has two attributes: a color (pattern) and symbol. To create a 1-Way match

you must match your stone with the stone on a board using one of your stone's two

attributes.

2. To create a 2-Way match you must place your stone using one of its attributes to

match one stone, and its other attribute for the second stone. The same attribute can-

not be used to match both stones.

3. To create a 3-Way match you must place your stone using one of its attributes to

match one of the stones, and its other attribute to match the other two stones. The same

attribute cannot be used to match all three stones.

4. To create a 4-Way match you place match your stone using one of its attributes to

match two of the stones, and its other attribute to match the other two stones. The same

attribute cannot be used to match more than two stones.
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ANCIENT AND MODERN WAYS OF PLAYING 

There are two modes of playing Ishidó: the Ancient Way and the Modern Way. Each

way uses a different system of scoring and emphasizes a somewhat different strategy.

The Ancient Way...Game and Scoring 

The Ancient Way of playing Ishidó emphasizes elegance and efficiency. The player

wins when he or she efficiently empties the pouch by placing all the stones on the

board. The player also creates as many 4-Ways as possible, because 4-Ways provide

the eleganceactor (refer to the Legend of Ishidó ).

The number of 4-Ways created appears on the lower portion of the scoreboard, next

to the symbols for4-Ways ( ). 

In Tournament and Challenge games, if several players empty the pouch, the player

with the most 4-Ways wins. If no one empties the pouch, the player with the most 4-

Ways wins. If no one empties the pouch and everyone has the same number of 4-

Ways, the player with the fewest number of stones left in the pouch wins.

The Modern Way...Game and Scoring

The Modern Way of playing emphasizes power. The goal is to score the highest num-

ber of points. Players can get high scores by creating 4-Ways as early in the game

as possible, as they strive to empty the pouch. 

Players receive points by placing stones in the light (interior) portion of the board (The

Within). These are called scoring matches. The greater the number of sides matched,

the greater the number of points earned. 

No points are given for stones placed in the dark perimeter squares (The Beyond). But

strategic use of non-scoring matches is essential.
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Points for legal matches:

Single-sided match 1 point

Two-sided match 2 points

Three-sided match 4 points

Four-sided match (4-Way) 8 points

Each 4-Way match earns bonus points and doubles all points awarded for subsequent

matches. For example, after the first 4-Way, a single-sided match earns two points, a

two-sided match earns four points, a three-sided match earns eight points, and a 4-

Way earns 16 points. The next 4-Way doubles the point scheme again, and so on.

Bonuses for each 4-Way match:

First 4-Way 25 points

Second 4-Way 50 points

Third 4-Way 100 points

Fourth 4-Way 200 points

Fifth 4-Way 400 points

Sixth 4-Way 600 points

Seventh 4-Way 800 points

Eighth 4-Way 1,000 points

Ninth 4-Way 5,000 points

Tenth 4-Way 10,000 points

Eleventh 4-Way 25,000 points

Twelfth 4-Way 50,000 points

Thirteenth 4-Way If you achieve thirteen 4-Ways matches 

you can stop worrying about points!
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At the game's end, bonuses are awarded when two or fewer stones remain in the

pouch.

Bonuses:

Two stones left in pouch 100 points

One stone left in pouch 500 points

Empty pouch 1000 points

Since 4-Ways double the points achieved by matches and produce bonus points, a

player who scores four 4-Ways without placing all the stones can actually score high-

er than a player who empties the pouch without creating any 4-Ways. 
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GAME MODES

You can play Ishidó by yourself in the Solitaire mode, or test your abilities against oth-

ers or the computer in the Challenge and Tournament modes. If you're feeling non-com-

petitive, you can settle into a Cooperative game and find out if two heads are better

than one!

Select the type of game you want from the Game menu. Then follow the instructions

for your game mode below.  In all games, if computer play is turned on, an hourglass

appears while the computer is making its move. 

Solitaire Game

In a solitaire game, the contestant plays alone.  Here's how to set up solitaire play.

1. In the Solitaire Game dialog box, select Ancient or Modern scoring. 

2. For the selection of players:

• Leave #1 Computer unselected to enable you to play a solitaire game.

• Select #1 Computer to have the computer play a game of solitaire. 

3. Choose New Game to begin the game with your designated scoring and player

choices. The board appears, set with the opening tableau of six stones.  Selecting OK

from the Solitaire Game dialog box and then New Game from the File menu also starts

the game at the opening tableau.

Challenge Game

In challenge play, you and one other player take turns placing the stones to complete

one game. You can also play against the computer. You can have the computer assume

the role of both players , and watch them compete against each other. Whether human

or computer, each player earns a separate score within the challenge game. 
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Here's how to set up challenge play.

1.  In the Challenge Game dialog box, you have several choices for player selection:

• Leave all computer player options unselected to enable you to play a challenge 

game with another human player.

• Select only #1 Computer to designate the computer as the challenge player 

making the first move. Select only #2 Computer to designate the computer as 

the challenge player making the second move. 

• Select both computer players to designate the computer as both players. 

2.  You can also choose to limit time for making a move (from one to 60 seconds)  by

selecting Timer: and moving the timer scroll bar to set the time limit for each move.

During a game, the seconds count down on the screen for each player. If the timer

runs out before a player places a stone, that player scores zero for the turn and the

timer begins again for the other player's turn.  

Leave Timer: unselected to allow an unlimited amount of time for each move in the

challenge game. 

3.  Then choose New Game to begin the game with your designated player and

timing choices. The board appears, set with the opening tableau of six stones. Selecting

OK in the Challenge Game dialog box and then New Game from the File menu

also starts the game at the opening tableau. 

Tournament Game

In Tournament play, you and any number of other players take turns playing entire

identical games–every player receiving the same opening tableau and drawing the

stones in the exact same order. Each player earns a separate score and the comput-

er can be one of the players in the tournament series.  An individual player can use

tournament mode to replay one game repeatedly to see how high he can score.
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As in regular play, each game in the tournament ends when the player empties the

pouch, when there are no more possible moves, or when the timer runs out.  Here's how

to set up tournament play.

1.  Select New Tournament in the Tournament Game dialog box.

2.  In the Tournament Game dialog box, select Ancient or Modern scoring. This sets

the scoring mode for all games in the tournament.

3.  You have two choices for player selection:

• Leave #1 Computer unselected to take turns playing consecutive games with 

other human players. 

• Select #1 Computer to designate the computer as the next player in the 

tournament. 

4.  Select Timer: and move the timer scroll bar to set the time limit for each game in

the tournament. You can set the timer from one minute to 60 minutes. During the game,

the minutes count down on screen. Or, leave Timer: unselected to allow unlimited time

for each game in the tournament. 

5.  Then choose New Game to begin a tournament with your designated scoring,

player, and timing choices. The board appears, set with the opening tableau of six

stones.  Selecting OK in the Tournament Game dialog box and then New Game from

the File menu also starts the first game of the tournament.

6.  After the current player ends a game, begin subsequent games in the tournament

by selecting New Game from the File menu. You can also begin a new game by

selecting Tournament from the Game menu and then New Game from the

Tournament Game dialog box. 

At the start of each new game, make sure the #1 Computer box is not selected if

you want a human to play next, or select it to let the computer play next.
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7.  Select New Tournament from the Tournament Game dialog box to begin a

new tournament.  Starting a new tournament creates a new shuffle (order of stones

in the pouch) and erases the current  scores in Tournament High Scores. 

Cooperative Game

In Cooperative play, you and a partner take turns placing the stones. You can also

play with the computer as your partner. Whether human or computer, players earn a

single, team score.  Here's how to set up cooperative play.

1.  In the Cooperative Game dialog box select Ancient or Modern scoring. 

2.  You have several choices for player selection:

• Leave the computer options unselected to take turns placing the stones with

another human player.

• Select #1 Computer to designate the computer as a cooperative player

which will make the first move.

• Select #2 Computer to designate the computer as a cooperative player

which will wait for you to make the first move.

• Select both computer options to designate the computer as both cooperative

players. 

3.  Then choose New Game to begin a cooperative game with your designated

scoring and player choices.  The board appears, set with the opening tableau of six

stones.

Selecting OK from the Cooperative Game dialog box and then New Game from

the File menu also begins the game at the opening tableau.
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Scoreboard and High Scores Display

Scores can be represented on the scoreboard graphically with tally marks (adapted

Roman numerals), or with standard numbers. 

Select Graphic Scoreboard from the Options menu to toggle between tally marks

and numbers. You can also double-click on the scoreboard to toggle between the two

representations. 

With Graphic Scoreboard turned on, these tally marks represent the following numbers

of points:

1point

5 points

50 points

100 points

500 points

1000 points

High scores appear on the Today's Scores, All-Time Highs, and Tournament High Scores

scoreboards.   Select Modern Scoring, Ancient Scoring or Tournament High

Scores from the High Scores menu to see these scoreboards. 

Today's Scores displays the highest scores of the day, from all game modes. Click

on Clear to erase the ...scores. The scoreboard will clear automatically when the

computer's internal clock indicates that a new day has begun. 

All-Time Highs displays the highest scores from all game modes. Click on Clear

to erase the scores from the board. If your score qualifies, a dialog appears when

you end the game which allows you to enter your name.

I
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Tournament High Scores displays the highest scores from tournament games.

Starting a new tournament erases game scores in Tournament High Scores.

Tournament game scores also appear on the Today's Scores scoreboard and are

eligible to appear on the All Time Highs scoreboard.

Show High Scores After Every Game lets you see high scores whenever you

end a game. Select Preferences, from the Options menu, then select Show high

scores after every game to make high scores appear automatically at the end

of each game.

In Tournament play Show high scores after every game makes the Tournament

high scores scoreboard appear.

Scoreboards for Modern Way keep track of points, the number of 4-Ways achieved

and the number of stones left remaining in the pouch. For Ancient Way they show just

the number of 4-Ways achieved and the number of stones left in the pouch.

Helpful Hints From Your Favorite Guru

Four types of assistance are available to help you place stones or plan your strategy.

To get these hints, select the Help menu and then choose:

• Undo Previous Move to put the stone you just placed back on the touchstone to 

be played again. 

• Show Possible Moves to see all legal moves for the stone currently on the touch

stone. 

• Always Show Moves to automatically see all legal moves each time a new stone

appears on the touchstone.

• Show Pouch to look at the stones remaining in the pouch.
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Caution: 

Selecting Show Possible Moves when there still is a legal move left to play dis-

qualifies you from making the All-Time Highs scoreboard. 

Turning on Always Show Moves, or looking at the pouch also disqualifies you from

making the All-Time Highs scoreboard. 

When you select Show Possible Moves, Always Show Moves, or Show

Pouch, however, you are given the option of returning to the game  without peeking

and without risking your chance to make the All-Time Highs scoreboard. 

(There is no penalty for using Undo Previous Move.)

Note: Show Possible Moves, Always Show Moves, and Show Pouch are not available

in Tournament play. Undo Previous Move is not available in Challenge play.
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STRATEGY 

To become a master player, you need to learn the art of emptying the pouch while

simultaneously creating as many 4-Way matches as possible. Utilizing all four corners

as well as the center of the board increases your chances of emptying the pouch and

creating 4-Ways. 

Learn how to plan ahead to make 4-Ways. You can build a strong game by antici-

pating possible moves based on the stones you know are still unplayed in the pouch.

Ancient Way Strategy 

In the Ancient Way of playing Ishidó, the primary goal is to empty the pouch by plac-

ing all the stones on the board. The secondary goal is to create as many 4-Ways as

possible. When competing against other players (or against your own personal best)
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and both players empty the pouch, the player with the most 4-Ways is the winner. If

neither player empties the pouch, the player with the most 4-Ways wins. If neither

player empties the pouch and each player has the same number of 4-Ways, the play-

er leaving the fewest number of stones in the pouch at the game's end wins. 

When playing the Ancient Way solitaire, your games are ranked on the high scores

display using the criteria stated above.

Modern Way Strategy 

In the Modern Way of playing, the goal is to score the highest number of points.  4-

Ways produce bonus points and double the point value of all subsequent moves. Thus

the ability to create 4-Ways often and early in the game is the mark of a power play-

er.  A premium (and scoring bonus) is also placed on emptying the pouch of all its

stones.

Center Master Play

In Center Master Play, you build upon the two center stones of the opening tableau

to create four 4-Way matches. Here are the steps for creating a Center Master Play.

Beginning:
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Progressing:

Center Master Play with the first 4-Way stone already played:
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Master Game

You have played a master game if you emptied the pouch and created eight 4-Way

matches around the six opening stones (four 4-Ways around the center stones and one

at each of the four corners). If you are playing at this level, congratulations! You're on

your way to becoming a legend! Here is an example of a Master Game in-progress

with the first six 4-Ways already played (indicated by the arrows) and two more set up:
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Using On-Line Help

You can get quick information about playing Ishidó from its on-line help. To use Help,

select Help... from the Help menu. Scroll down the list of topics and select the topic

you want by double-clicking on the heading or highlighting it and selecting Help.

When you select the topic you want from the Help list, information on it appears in a

Help information dialog box. Scroll through the text to read the information in the box.  

• Topics returns you to the list of topics in the Help Topics dialog box. 

• Next or Previous makes the next or the previous Help Information dialog box appear.

• Done lets you exit Help and return to the game.

Reading about one Help topic may spark your interest in a related topic. Terms which

are further explained in related Help topics are underlined in the Help Information dia-

log box text. Click on the underlined text to go directly to the appropriate spot in the

related Help Information dialog box.

Looking at a related help topic makes Previous change to Go Back. Select Go Back

to return to the help topic you were reading before you chose the related topic. 

Font, Sound, and Message Preferences

I s h i d ó lets you change the font used for menu and dialog boxes, turn sounds on or off, and

turn messages on or off. Select the Options menu then follow the instructions below:

Fonts 

Select Preferences... then select The Ishidó font or The System font to use in menus

and dialog boxes. 

Sounds

Select Sounds to turn off the special effects sounds in the game: gongs, wind chimes,

and harp. Select Sounds again to turn the sounds back on.

When you're not playing Ishidó, you can play the wind chime sound continuously as
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background music by opening Ishidó and selecting About Ishidó... from the Yin/Yang

menu (Apple menu if using the system font). Click once to close About Ishidó... and turn

off the chimes.

Note: The Apple menu symbol is a yin/yang symbol if you are using the Ishidó font.

Stone Click 

Select Stone Click to turn off the stone click sound that accompanies each move.

Select Stone Click again to turn stone clicks back on. 

Messages

The Ishidó Guru-in-a-Dialog-Box is ever ready to help when you commit errors during

gameplay. There are no penalties for getting these messages. Select Messages to

silence the guru and remove the checkmark beside the menu item. Select Messages

again to benefit from the guru's wisdom. Most of the stonesets provided with the game

invoke their own individual guru.
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CUSTOMIZING ISHIDÓ 

Variety is the spice of Ishidó. You are provided a variety of stonesets, backgrounds

and playing boards to choose from and play with, in both the black & white and

color versions of Ishidó. 

Choosing a Stoneset

Follow these steps to view and choose an Ishidó stoneset: 

For Black & White Version

1.  Select Stoneset... from the Options menu. The Choose a stoneset: dialog box dis-

plays a graphic sample of six stones from the current stoneset. 

2.  Click on the button for one of the other Ishidó stonesets to see a sample of its stones.

Double click on any stone icon to see all 36 unique stones in the stoneset. Select OK

to close the View Stoneset dialog box and return to the Choose a stoneset: dialog box. 

3.  Click on OK to close the Choose a stoneset: dialog box and return to Ishidó. Your

stoneset of choice appears on the board if you have a game in progress. 

Select Cancel to close the Choose a stoneset: dialog box without selecting another

stoneset. 

Note: You can change a stoneset at any time, even while a game is in progress.

For Color Version

1.  Select Stoneset... from the Options menu. The Choose a stoneset: dialog box dis-

plays a graphic sample of six stones from the current stoneset. 
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2.  Click on the scroll bar arrows to view one of the other Ishidó stonesets.  Double

click on any of the stones or select Edit to view all 36 unique stones in the stoneset.

Select OK to close the View Stoneset dialog box and return to the Choose a stone-

set: dialog box. 

Important: If using the color version of Ishidó with Multifinder you will sometimes find

that the color palette will shift. This can easily be corrected by selecting Stoneset…,

Background… or Board… and clicking OK. Also, the sample of six stones in the

Choose a stoneset: dialog box sometimes will display an incomplete color palette. Thus

you are not always viewing an accurate representation of the stoneset's full range of

colors. However, the entire color palette will be loaded in if you view the whole stone-

set as described in #2 above, or if you load the stoneset into the game.

3.  Click on OK to close the Choose a stoneset: dialog box and return to Ishidó.  Your

stoneset of choice appears on the board if you have a game in progress. Select

Cancel to close the Choose a stoneset: dialog box without selecting another stoneset. 

Note: You can change a stoneset at any time, even while a game is in progress.

Choosing a Background

More spice! You can choose among dozens of Ishidó backgrounds to use behind the

game board in both black & white and color versions.  

Black & White Version

1.  Select Background... from the Options menu. The Choose a board: dialog box

displays the background currently in use. 

2.  Click on the name or button for one of the other backgrounds to see it in the pat-

tern view box. 

You can also click on Standard Patterns: or Special Patterns: and move the

scroll bar to see a sample of additional backgrounds. 

3.  With your background selected, click on OK to close the Choose a board: dialog
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box and return to Ishidó. Your pattern appears as a background behind the board.

Select Cancel to close the Choose a board: dialog box without changing the current

background pattern.

Note: You can change a board background at any time, even while a game is in

progress.

Color Version

1.  Select Background... from the Options menu. The Choose a background: dialog

box displays the background currently in use. 

2.  In the color version you can choose either Picture backgrounds or Color back-

grounds. Picture backgrounds use objects of any size and then repetitively pieces them

together to form the entire full screen background. Color backgrounds utilize a color

wheel and enable you to choose any of thousands of different colors to use as your
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background. 

Click on the scroll bar arrows to move through the selection of backgrounds. Click on

either the Color or Picture radio buttons to move between the two types.

3.  With your selected background showing in the box, click on OK to close the Choose

a background: dialog box and return to Ishidó. Your pattern appears as a background

behind the board. Select Cancel to close the Choose a board: dialog box without

changing the current background.

Note: You can change a background at any time, even while a game is in progress.

Choosing a Board  (available in color versions only)

In color versions you have the option to choose from a variety of boards to go with

your stonesets and backgrounds.

1.  Select Board... from the Options menu. The Choose a board: dialog box displays

a reduced graphic example of the board currently in use.

2.  Click on the scroll bar arrows to view one of the other Ishidó boards. Select OK

to close the Choose a board: dialog box and return to the game. Select Cancel to

close the Choose a board: dialog box without changing the current board. 

Note: You can change a board at any time, even while a game is in progress.
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THE ART OF STONES

As the "Legend of Stones" relates, Ishidó has always been much more than a game. The

following sections will provide you entré into the world of the Art of Stones, where-

in you customize and create your own stonesets, backgrounds, and (in the color version)

playing boards.  If you have a sense of adventure and/or a creative bent, you'll find

these graphics editors surprisingly powerful. 

Experiment. This aspect of the game can be very satisfying and will provide hours of

entertainment in a form you probably didn't expect when you acquired your edition of

Ishidó.  These instructions are just the beginning. Before long you could be creating

Ishidó graphics using methods that we hadn't even envisioned. 

Creating and Editing Stonesets

If you get tired of using the ready-made Ishidó stonesets or simply desire a more per-

sonalized set, just create your own!  With its sophisticated graphics editors Ishidó lets you

create entirely original stonesets or copy and edit those that came with the program. 
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What is a Stoneset?

An Ishidó stoneset must have six different symbols and six different colors or patterns.

Each symbol repeats across one of the six rows in the stoneset. Each color (pattern)

repeats down one of the six columns in the stoneset. Applying the six colors or pat-

terns to six symbols creates 36 unique stones. These 36 stones are one set in the pair

that makes up a stoneset of 72 stones. 

Black & White Versions

Let's start from scratch to make an original stoneset. Follow these steps:

1.  Select Stoneset... from the Options menu. The Choose a stoneset: dialog box

appears.

2.  Select Other: to make the scroll bar appear. Scroll to the far left to select the

blank stoneset.
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3.  Select New. The New Stoneset dialog box appears

4.  Click once on the stone at the upper left (first row and first column). Double click

on the stone or click on Edit to see the Stone Editor.
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Stone Editor

Zoom View Box – Create your stone drawing here.

Actual Size View Box – Shows the actual size of your design as you draw.

Pattern View Box – Shows current Standard or Special fill pattern used by the

paint bucket.  Select Standard or Special and scroll to select the pattern you want.

Design Tools – Select these to create your drawing. See the Design Tools section

for a description of how each tool works.

5.  Select any design tool and place the cursor over the stone in the Zoom View Box

to work on your drawing. Please see the Design Tools section for information on

using each tool.

6.  When you're satisfied with your drawing, select OK to save the drawing to the

selected stone and return to New Stoneset.
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Selecting Cancel returns you to to the New Stoneset dialog box without saving your

drawing.

7.  Select the first stone in the second row. Double click on it or select Edit to open

the Stone Editor again,  and follow steps five and six above to draw a different design.

Continue down the column, drawing designs on the first stones in the third, fourth, fifth

and sixth rows.

8.  Click on the white space to the left of the stones (this deselects all the stones), then

select Copy to Row. Each drawing is duplicated across its row, filling the stoneset. 

Selecting an individual stone and then selecting Copy to Row copies only the draw-

ing on that stone to all the other stones in that specific row.

9.  Once again, click on the white space to the left of the stones. Then select Make

Mask. The area in the stone appears as a solid block, or mask. 
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Note: The mask is necessary in black & white versions to provide a background for

each stone so that it appears opaque when placed upon the board or touchstone.

Without the mask the stones would be transparent wherever they are white. This

apparent limitation of b/w graphics can actually be used to create interesting effects.

See Creating Transparent Stonesets later in the manual.

10.  Click on any stone, then select Fill Column.... The Choose a board: dialog box

appears. Select the pattern you want by clicking on named patterns or scrolling

through the list of Standard or Special patterns. The pattern you select appears in the

pattern view box. 

Note: You must create your mask before you can use Fill Column… to fill your stoneset

with background patterns.

Note: You can create a new pattern or edit an old pattern whenever the Choose a

pattern: or Choose a board: dialog box is open. See the Creating and Editing

Backgrounds section to find out how to make new patterns or edit existing patterns.  

Note: The Fill column… command is an expedient way to place background pat-

terns on your stones.  An alternative and more precise method is to fill stones individ-

ually using the paint bucket from the Edit Stone screen.
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11.  When you see the pattern you want in the pattern view box, select OK. The Choose

a pattern: dialog box closes and the pattern appears over all the stones in the column. 

Note: It is standard to place the stones with the lightest color background in the first

column and the stones with the darkest color background in the sixth column.

12.  Repeat steps 10 and 11 above to fill in background patterns for the stones in the

remaining columns. 

13.  When you have finished your stoneset, select OK in the New Stoneset dialog box

to save the stoneset to the Other: menu. The Choose a stoneset: dialog box appears

with a sample of your new stoneset. 

Note: The sample area in the Choose a stoneset: dialog box shows only the stones from

column 1, not the entire stoneset.

Selecting Save saves the stoneset without exiting the Choose a stoneset: dialog box.

Selecting Save and then Cancel saves the stoneset and returns you to the Choose a

stoneset: dialog box without selecting your stoneset from the Other: menu.
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Editing Your Stoneset

After you have created a stoneset, you may want to go back and make changes to

it. Follow these steps to edit your stoneset:

1.  Select your stoneset from Other: then select Edit in the Choose a Stoneset dialog

box.

Selecting Edit lets you make changes to the stoneset and replace the old version with

the changed version.

Selecting New lets you make changes to the stoneset and save the new version as

an additional stoneset, keeping the old version intact.
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2.  Select the stone you want to edit and choose Edit to open the Stone Editor.

3.  Use the Design Tools to make changes to your drawings and background patterns. 

Note: When you select a stone to edit its drawing, the old background pattern on the

stone becomes part of the new drawing. Copy to Row replaces the old drawing and

background pattern of all the stones in the row with the new drawing, which now

includes a background pattern.

Note: When you change the background pattern on a stone, Fill Column... replaces

the old background pattern of all stones in the column with the new background pat-

tern, but does not erase the current drawing. 

Note: If you want to change both the drawing and the background, select a stone, edit

the drawing on it, and use Copy to Row to copy the drawing across the row. Then

use Fill Column... or the paint bucket to restore or change the background pattern

down each column. 

4. When you are satisfied with your changes, select OK in the Edit Stoneset dialog box

to save the edited stoneset to the Other: menu. The Choose a stoneset: dialog box

appears with a sample of your new stoneset. 

Selecting Save saves the stoneset without exiting the Choose a stoneset: dialog box.

Selecting Save and then Cancel saves the stoneset and returns you to the Choose a

stoneset: dialog box without selecting your stoneset from the Other: menu.

Copying & Editing a Ready-Made Ishidó Stoneset

Instead of creating a stoneset from scratch, you may want to modify one of the stone-

sets that come with Ishidó. Since these stonesets are locked and can't be directly mod-

ified, to do this you must copy and paste the Ishidó stoneset you want to the Other:

menu and then edit the copy of the stoneset. 
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Follow these steps:

1.  In the Choose a stoneset: dialog box, select the named Ishidó stoneset you want

to copy.

2.  Select View.

3.  In the View Stoneset dialog box, select Copy then select OK. The Choose a

stoneset: dialog box reappears.

4.  Select Other: and scroll to the empty stoneset. 

5.  Select New. The New Stoneset dialog box appears with the blank stoneset. 

6.  Select Paste. The stoneset you selected appears pasted over the blank stoneset. 

7.  Select OK to save your stoneset to the Other: menu. Now you're ready to edit

your copy of the original stoneset.

Creating a Stoneset Template

In the black & white game the first two stonesets in the Other: menu are blanks (one

is rectangular, the other is oval). They are provided to use as templates for creating

new stonesets. In a burst of enthusiasm you  may accidentally select Edit instead of

New to draw a design, then save the new stoneset over the template. The template,

of course, will then be lost. Follow these steps to restore the template:

1.  In the Choose a stoneset: dialog box, scroll to any stoneset in the Other: menu. 

2.  Select New. The New Stoneset dialog box appears, showing the selected stoneset. 

3.  Select Clear. The entire stoneset disappears.

4.  Click on the spot where the stone in the first column and row usually appears. The

selection box appears. 
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5.  Now select Edit to make the Stone Editor appear.

6.  In the Stone Editor, select the rectangle tool and place the crosshair cursor at the

top left pixel of the zoom view box (illustration A.). Click and drag the crosshair until it

makes a border in the zoom box (illustration B.).

7.  Select the pencil tool. Click on the top right and lower left pixel of the border to

erase them.

8.  Select the line tool. Draw a line along the right and lower edges of the border.
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9.  Select OK. Your empty stone appears at the top left of the Edit Stoneset dialog

box. With the stone still selected, select Copy. Select the spot beneath the stone, then

select Paste. Select and paste four more times, creating stones all the way down the

first column. 

10.  Click to the left of the first column of stones, outside the stones, then select Copy

to Row. Your blank stones appear across each row.

11.  Click on white space outside to the left of the stones (under Revert), then select

Make Mask . The area in the stone appears as a solid block, or mask. The mask

enables the stone to appear opaque against the board and touchstone. (Always cre-

ate the  mask  before you fill with background patterns.)

12.  Select OK to save the stoneset template to the Other: menu and return to the

Choose a stoneset: dialog box. 
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Creating a Partially Transparent Stoneset

Although the stoneset template is a useful tool for creating stonesets, you don't have

to  stick to solid, rectangular shapes for the stonesets you create. Of the stonesets that

come with Ishidó, Genesis, Runes, Magica, and Ramses have shaped stones. The

Genesis stoneset even has holes in several of its stones.

To modify the shape of a stone and create "holes" or transparent places in it, you need

to modify the mask, or opaque layer beneath the stone. Follow these steps to reshape

the mask as you create a new stoneset:

1.  Using the stoneset editor of  New Stoneset, "chisel" away at the stone border by

redrawing it. Create the drawing on the stone; copy it across the row. Complete the

drawings for the other stones in the stoneset.

2.  When you make the mask for each row, the mask takes the same shape as the

"chiselled" stones in the row. 



3.  To put a "hole" in a stone, select the mask for the row with the hole in the design.

Use the eraser or pencil to erase the portion of the stone which corresponds to the

hole in the stone.

4.  Save the stoneset. When you play a game with the stoneset, notice that the "chis-

elled" portions of the stone or holes are transparent against the touchstone and the

board.

5.  Feel free to experiment with your masks. Try gray or patterned masks instead of

black ones…for semi-transparent stones. And remember, the masks can be edited

exactly as the stones are edited when you double click on them. You can create some

very mysterious effects by altering the masks.

Using Other Paint Programs to Design Stonesets 

You can use other paint programs to create and enhance your stonesets. Follow these

steps:

1.  Select the stoneset you want to enhance and copy it. Copy one of the templates

if you want to create your stoneset from scratch using your paint program.

2.  Under the desk accessory menu, open the scrapbook. Paste the stoneset into the

scrapbook.  (Or, if you are using Multifinder, paste it directly into your paint program.)

Note: Under some b/w configurations the stoneset will not be visible in your scrap-

book. Rest assured, however, it is there. Simply assume the blank appearing page is

your picture and continue.

3.  Close the scrapbook, quit Ishidó and open your paint program.

4.  Open the scrapbook (see note above) and paste the stoneset into your paint pro-

gram.
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Note: As you work on the stoneset in your paint program, do not separate or move

stones around. This can create havoc when you paste the stoneset back into the pro-

gram. 

5.  When you finish enhancing the stoneset, copy it back into the scrapbook (or go

directly to the next step if you are using Multifinder). Close your paint program and

open Ishidó.

6.  Select a stoneset in the Other: file and select New in the Choose a stoneset: dia-

log box, then Clear the stoneset.

7.  Select Paste to paste the enhanced stoneset over the cleared Ishidó stoneset, then

save the stoneset. 

Creating a Stoneset for Color Versions

Using Ishidó's Stone Editor

Creating and editing stonesets in the color version is very similar to the method used

in the black and white version. However, there are some differences:

1.  You are now working in color rather than B&W, so you have one additional tool:

the eye dropper. Choose the eye dropper, point its tip to a color which you wish to

work in—either from the palette of available colors to the right of the dialog box or

from the drawing of the stone itself—and click the mouse button. Now your pencil, paint

bucket, line draws, etc. will all be drawn in that color. You can conveniently access the

eye dropper any time when using another design tool by toggling with the Control Key.

Colors also can be selected with the arrow cursor by clicking on the color of your

choice in the color palette .

2.  There is no need to create masks in the color version. All colors, except transpar-

ent white, are opaque.
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3.  Empty stoneset templates are not provided with the color version, so you'll either

have to choose an existing stoneset to use as a template or make one yourself. You

choose an existing stoneset to use as a template by scrolling to the stoneset you'd like

to begin with, then selecting New.

4.  You can give your new stonesets names in the color version, or change the name

of existing stonesets.

Note: Stonesets provided with the original versions of Ishidó are locked and cannot be

directly altered. However, you can simply choose New to create a copy to work on.

Note: The stone editor within Ishidó does not enable you to change the color palette

from within the program. To do this you must use a color paint program as described

in the following section.

Creating Color Stonesets With Your Own Paint Program

There are many effects and tools which most color paint programs have which make

creating stonesets  a delightful experience. Follow these directions to create stonesets

using your own color paint program.

1.  Select Stoneset... from the Options menu. The Choose a stoneset: dialog box

appears. Scroll to the stoneset you would like to use as a template.

2.  Select Copy. Select Cancel. Then paste to your scrapbook, quit Ishidó, open your

paint program, copy the stoneset from the scrapbook and paste it into the paint pro-

gram (if you are using Multifinder, paste directly into your color paint program). At this

point you are free to create, change, play and add color within these limitations:

• Do not alter the format; use the stoneset you've copied as your template. This

is to ensure that when you copy the stoneset and place it back into the game it fits

properly.
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• Your color palette is limited to 150 colors (the remaining color slots are reserved

for the board and backgrounds). Optimize your color palette before importing your

stoneset back into Ishidó by customizing your palette and clearing all colors except

those used within the stoneset. This will minimize the likelihood of experiencing

incomplete or altered color palettes when playing the game.

3.  When your stoneset is complete and you are ready to paste back into Ishidó, copy

it using the shrink/transparent option. Paste into your scrapbook or return to the game

using Multifinder.  Once back in the game select Stoneset... from the Options menu.

The Choose a stoneset: dialog box appears.

Important: Use of the Scrapbook under Multifinder frequently causes loss of the true

color palette. Simply select Stoneset…, then OK to reassert the correct color palette

within the game program.

4.  Move the scroll bar to the stoneset after which you want your new stoneset to be

placed and select  Paste. Voila! Your new stoneset is now in the game and ready to

be played.

5.  Select Name Stoneset… to enter a name for your stoneset. 

6.  After playing with your new stoneset, you might wish to touch it up a bit. Select Edit

to touch it up within the program. Notice that the new color palette now is the one

you imported into the game with your new stoneset.

Creating and Editing Backgrounds & Patterns

In addition to designing stonesets, Ishidó lets you create and edit your own original pat-

terns and colors to use for game board backgrounds, stoneset backgrounds, and paint

bucket fills. 
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Black & White Versions:

1.  Select Background from the Options menu. 

2.  Click on Standard Patterns: or Special Patterns:. Move the scroll bar until

you see the background you want to modify.

3.  Select New or Edit to open the Pattern Editor.

Select New if you want to create and add an additional background in the

Standard Patterns: or Special Patterns: menus. 

Select Edit if you want to change and replace a current background.

You can also edit a pattern while in the process of creating or modifying a stoneset,

by opening the Pattern Editor when using Fill column…  or filling in stone backgrounds

with the paint bucket. 
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Standard Pattern Editor

Zoom View Box - Create your pattern here.  

Actual Size View Box - Shows the actual size of your design as you draw.  

Design Tools - Use these tools to work on your pattern. 

Special Pattern Editor
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Zoom View Box – Create your pattern here.  

Expand/Compress Tool – Use this design tool to modify the size of your pattern.

Actual Size View Box –  Shows the actual size of your design as you draw.  

Design Tools – Use these tools to work on your pattern. 

4.  Use the design tools to create the pattern you want in the zoom view box. 

5.  Select OK to save your background design and return to the Choose a board:

dialog box.

If you are working in New Pattern, selecting OK closes the Pattern Editor, saves

your new pattern as an additional pattern in the Other: menu, and returns you to the

Choose a board: dialog box. 

If you are working in Edit Pattern, selecting OK closes the Pattern Editor, saves your

new pattern over the old pattern, and returns you to the Choose a board: dialog box.

Selecting Cancel in the Pattern Editor returns you to the Choose a board: dialog box

without saving your work.

6.  Selecting Cancel in the Choose a board: dialog box returns you to Ishidó with-

out placing the new background pattern behind the board. Access your new back-

ground by scrolling through the Other: menu. 

Selecting OK in the Choose a board: dialog box returns you to Ishidó and places

your new pattern as a background behind the board. 

Selecting Delete in the Choose a board: dialog box permanently erases the current

background in the pattern view box.
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Color Versions:

The color versions of Ishidó allow you to use either pictures or solid color fills as back-

grounds behind the playing board.

Pictures

Pictures are created with your own paint program and then imported into the game.

The possibilities are almost infinite. Just remember that Ishidó's graphics editor uses the

picture, whatever its size, to fill the entire screen. So that, for instance, if you imported

just one black pixel, that picture would be repeated and juxtaposed such that the entire

background would appear black. Here's how some of the backgrounds you received

with the game were created:

1.  All gradient backgrounds (the ones that go from dark to light, or form rainbow-like

patterns) use a single picture about 15 pixels wide and 400 pixels high (the exact full

height of the screen). Simply choose the colors of the gradient and use a gradient fill

function with the rectangle tool to create a tall, thin strip of color.

Then copy this using the shrink/transparent tool (or any method that does not include a

black or white outline), paste to your scrapbook  (or move directly to the game using

Multifinder) and open Ishidó, select Background… from the Options menu, select

the Picture button, and Paste.

If yo u 're curious about how any of the backgrounds were cre a ted, select

Background… from the Options menu, select the Picture button, and Copy it.

Paste it into any color paint program and check it out!

Important: Use of the Scrapbook under Multifinder frequently causes loss of the true

color palette. Simply select Background…, then OK to reassert the correct color

palette within the game program.
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Colors

Ishidó allows you to choose from the Mac’s 16.8  million colors to use as your back-

ground. Select Background… from the Options menu, select the Color button,

then select Choose Color…. This will take you to the Choose a new color: Color

Wheel (which is Apple's standard color picker).

The Color Wheel allows you to modify six variables: Hue, Saturation and Brightness,

and levels of Red, Green and Blue to create virtually any color your heart desires.

You can do this scientifically by changing the numerical values and moving the scroll

bar; or intuitively by moving the cursor over the  circle (it becomes a little black cir-

cle) and clicking. 

Experiment with this tool. It's very easy and lots of fun to use.

Creating New Playing Boards (Available in color version only)

Ishidó allows you to create new boards in your color paint program and import them

into the game. 

Follow these steps:

1.  Select Board… from the Options menu. This brings you to the Choose a board:

dialog box. Select a board to use as a template then select To disk…. Name it and

save it. 

Note: It's advisable to start out using the plain black & white tile board as your first

template.

2.  Open the file you just saved from within your color paint program. You are now

ready to create your own board. Remember that the template is used to guide place-

ment of the board's outer dimensions, the placement of the squares on the board, and

how you situate the touchstone, scoreboard and pouch.

Every element of the board as mentioned above is customizable. You might want to

experiment with transparent and semi-transparent boards (using transparent white),
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and even go beyond the parameters and dimensions of your template.

3.  When you are satisfied with your creation save the file. Then reenter Ishidó, select

Board… from the Options menu, and select From Disk…. Find the file you just saved

with your customized board in it and Open it.  Ishidó automatically imports the board

into the game. Choose OK and the game is now ready to be played using your new

board.

Note:  If you wish to view your board without any stones on it after having already

begun playing a game, select the Game menu, choose the game mode you are in,

then click OK. This will return you to an empty board.

Trial and error and your own ingenuity will show you just how far you can vary from

the parameters of the template. We know someone who copied in one transparent

white pixel and plays his game against the background with no board visible at all. 

Important: Importing backgrounds under Multifinder frequently causes loss of the

true color palette. Simply select Board…, then OK to reassert the correct color

palette within the game program.
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Design Tools

Here are the design tools available in Ishidó's graphics editors:

Tool Use and Function

Drag the hand to move the stone in any direction in the zoom view box. 

Drag the brush tip across the stone face to paint freehand. The paint

flows as long as you hold the mouse button down.  Double click on the

icon to fill the whole box with paint.

Drag the crosshair from a starting point and release th

mouse button at the ending point to draw a line

Drag the crosshair diagonally from a starting point and release the

mouse button at the ending point to draw a rounded rectangle.

Drag the pencil in any direction you want to draw freehand.  Release the

mouse button at the ending point. If you start  drawing over a white area,

the pencil draws in black. If you start over a black area, the pencil draws

in white.

Hold down the mouse button and sweep it back and forth to erase

everything underneath it. Double click on the icon to erase everything. 

Drag the crosshair diagonally from a starting point and release the

mouse button at the ending point to draw an oval or circle.

Drag the crosshair diagonally from a starting point and release the 

mouse button at the ending point to draw a square.
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Place the paint bucket within an enclosed area and click to fill the area

with the pattern appearing in the Pattern View Box. Paint flows from the

tip of the bucket's spill. If black dots do not completely enclose the area

you want to fill, a spill results. 

Place eye dropper on any color, click mouse button, and whichever tool

you use…pencil, paint bucket, etc.…you will be working in that chosen

color. You can access the eye dropper and toggle back and forth

between it and other tools by holding down the Control key. (Available

in color versions only.) 

Click on and drag the handle of the Expand/Compress tool to change ..

the area for your pattern. The range is from 8x8 pixels to 32x32 pixels. .

Notice that increasing the size of the Zoom View Box decreases the num-

ber of times the pattern can repeat. Decreasing the zoom box are makes

the pattern repeat more often. (Available in black & white versions only.)

Clicking on these tools has the following effect on your graphic:

Tool Result

Inverts all colors, changes all white areas to black, and black areas to 

white. Choosing invert again restores the drawing to its original state

Rotates the drawing 90 degrees to the right.

Rotates the drawing 90 degrees to the left.

Flips the drawing so that its top and bottom trade places.

Flips the drawing to a mirror image of itself.
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Undo Erases the most recent drawing operation. Selecting Undo repeatedly 

restores or reverses the most recent drawing command.

Clear Erases the selected stone or stoneset.

Revert Restores the last saved version of your stoneset.

Copy Moves the selected stone or stoneset to the clipboard.

Paste Moves the selected stone or stoneset from the clipboard to the selected 

location.
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Moving Stonesets, Backgrounds and Boards  

After you create your own stonesets and backgrounds, you can save them to diskette

and move them between computers or swap them with friends. We use the black &

white version exclusively in the following tutorial. However, the instructions are essen-

tially the same for color as for black & white. The only differences being that with color

you move picture backgrounds instead of standard and special patterns, and you can

also move playing boards.

Follow these steps to move Ishidó graphics from your hard disk or Ishidó diskette to a

friend's diskette or from a friend's diskette back to your hard disk or Ishidó diskette.

Please refer to your Macintosh user manual if you need additional information on the

hierarchical file system. 

1.  Select Stoneset... or Background... from the Options menu and choose Mover...

from the Choose a Stoneset: or Choose a board: dialog box. The Mover dialog box

appears. 

2.  Select either Stoneset, Standard Pattern, or Special Pattern, depending

on what type of file you want to copy.
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3.  Select the Open... button beneath one of the scroll boxes to see lists of files and

folders and find Stoneset, Standard Pattern, and Special Pattern files on the current disk

or in the current folder. If you don't see Open... below a Mover scroll box, first click

Close to close the currently displayed file. 

Select and open (or double click on) any folder to see the files or other folders in it

(moving away from the disk directory). Press and drag on the directory title to see what

other files or folders are on the disk directory (moving toward the disk directory). 

To look for stoneset or background files on other disks, insert the disk in the drive. Use

the Drive button or use the Drive and Eject buttons to look for stoneset or back-

ground files on other disks or on your disk drive. The name of the disk you're looking

at appears at the top of its corresponding list dialog box, soon after you insert the disk.
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4.  Open the file you want to look at by selecting its name and then clicking Open...,

or by double-clicking its name. If it contains the type of file you specified (Stoneset,

Standard, or Special Pattern), one of the patterns or stonesets appears in the Mover

scroll box. If the file or folder you chose does not contain the type of pattern --

Stoneset, Standard Pattern, or Special Pattern -- you indicated above, then the Mover

scroll box will appear empty.

You can look at and work with any existing stoneset or pattern file. Both the name of

the file you have open and the name of the disk or drive it's on appear below the

appropriate Mover scroll box. 

5.  Once you open a file, you can use the scroll bar to look at all the stonesets or pat-

terns in the file. 

The line near the top arrow of the scroll bar indicates the number of stonesets or pat-

terns in the current file and the number of the current graphic. In the figure above, the

file on the hard drive (left side) contains seven stonesets. A sample of the third stone-

set in the file appears in the Mover scroll box. The file on the diskette (right side) con-

tains eight stonesets. A sample of the eighth stoneset in the file appears in the Mover

scroll box. 

6.  Insert a formatted diskette into your disk drive and select Open... underneath the

empty Mover scroll box.  Select and open the file containing the stonesets or patterns

you want to copy to or from, just as you did in steps 3, 4, and 5 above. 

7.  Click on one of the Mover scroll boxes to select the stoneset or background pat-

tern you want to copy. This is the active Mover box. You can select from the box on

the right or on the left. The arrows around Copy point toward your stoneset or pat-

tern's destination.

8.  Click Copy to copy the stoneset or pattern displayed in the Mover scroll  box to

the destination diskette. A sample of the stoneset copy appears in the destination



67ISHIDO™

Mover scroll box. The number of stonesets or patterns in the destination file increases

by one. 

Copy All copies all the stonesets, patterns, backgrounds or boards from the file dis-

played in the active 

Mover box to the destination file.

Remove erases the stoneset, pattern, background or board displayed in the active

Mover box.

Remove All erases all the stonesets, patterns, backgrounds or boards from the file

displayed in the active Mover box.

You can create a new file for storing your own collection of stonesets, patterns, back-

grounds and/or boards by clicking New..., typing in a name for the file at New stone-

set/pattern file:, and then selecting Save.

Specifying Format for Your Graphics Files 

Save Screen to Disk... from the File menu saves a screen of the game board dur-

ing play as a paint file on your hard disk or diskette. Select the folder you want to

contain the file. Then type in the name of the file at Save screen as: and select Save. 

Ishidó's Document Editors feature lets you save a screen in the application format you

specify. Specifying the application you want lets you open the graphics file and the

application at the same time. If you don't specify a format, you must first open your
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MacPaint compatible graphics processing application, and then use it to open the

graphics file. 

Follow these steps to select the graphics processing application on your system:

1.  Select Preferences. At Document editors: select Paint Files by clicking once

inside the rectangular box. A scrollable list box appears, showing the current file or

folder.

2.  Locate and select the graphics application you want to use and select Open. The

Document editors: dialog box appears with the name of your graphics application

after Paint files:.

3.  Select OK to close the Preferences: dialog box and return to Ishidó.  Select Cancel

to close the dialog box without saving your graphics format choice.

Note: If you do not select a graphics application, Ishidó saves stoneset and background

screens as MacPaint-compatible PICT files in the black & white versions, and as PICT

files in color that can be opened from within all current color paint programs. 
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THE ORACLE OF THE STONES

The Oracle of the Stones is a system of divination based on the principle of syn-

chronicity*–the theory that the coincidence of events in time and space involves some-

thing more than mere chance. What we take as haphazard or accidental–for exam-

ple, the arrangement of the stones in the 4-Way pattern from their random order in

the pouch–depends not only on the physical reality of the stones available to be

played, but on the state of mind and conscious choices of the player as he or she

places each stone. 
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The Oracle of the Stones uses this meaningful coincidence as an instrument for gain-

ing insight into a situation or question posed by the player.

Divination is frequently thought to be an attempt to tell the future. However, authentic

divination is not invoked for the purpose of fortune-telling. Instead it is simply a tool–one

which, when correctly utilized and understood, allows profound examination of the

fullest potentiality of a given situation. 

The oracle readings, or auguries, produced by the 4-Ways reflect the questioner's state

of mind at the precise moment the 4-Way pattern comes into existence. Brief and at

times cryptic, the auguries challenge and assist questioners to divine, or figure out by

intuition, an appropriate response to the problem or question he or she brought to the

oracle's attention. The purpose of this act of divination is to assist the questioner in dis-

covering a fresh perspective on the problem–and, hopefully, to uncover an effective

and ethical solution.

* The term "synchronicity" was coined by Swiss psychologist C. G. Jung. For an excellent discussion

of this concept, please refer to "Synchronicity: An Acausal Connecting Principle," The Structure and

Dynamics of the Psyche  (Collected Works of C.G. Jung, volume 8).
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Traditional Oracles and Computer Oracles

Oracles have existed since the dawn of civilization.  Consulting one has always

required the discipline to learn the appropriate–and frequently intricate–divination

techniques, and the patience to execute them conscientiously. These techniques were

purposely designed to create an optimized time and space for questioner and ora-

cle to merge, and become as one. Thoughtfulness, sincere intention, a willingness to

momentarily suspend disbelief, and a meditative state of mind form the best founda-

tion for consulting oracles. 

Webster defines an oracle as "a shrine through which hidden knowledge is revealed."

The computer is certainly a most appropriate oracle for our new age. Perhaps the

most powerful tool any of us has ever possessed, our computers frequently do seem

to reveal hidden knowledge. Some of us are so enchanted by, and enamored of, their

power and complexity that we really do relate to our PCs as shrines! Nothing would

delight an ancient sage's well-developed sense of life's sublime ironies more than our

use of the computer–the epitome of logic–to produce results which defy logical

explanation. 

Using the Oracle of the Stones

So, how do you use Ishidó's computerized oracle? There are four steps: figuring out

the question you want to ask, asking it, creating a 4-Way match, and then interpret-

ing the augury that results from the 4-Way.

First, Formulate the Question

Questions that can be answered with a simple "yes" or "no" don't usually work well,

because they can't tap the richness of the oracle's response. Instead, try questions like:

"What will be the outcome if...?" or "What effect will such an action have on...?" or

"What do I need to know about...?"  This kind of thoughtful questioning encourages a

more lucid state of mind and allows the oracle's response to be both appropriate and

comprehensible.

Another technique is to make one to three queries around a specific subject. The ques-
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tioning could go something like this:

• "Please describe my present situation in regard to..."

• "What is the best path to follow in this situation?"

• "What else do I need to know?"

Experience shows that asking too many questions on a subject frequently muddies the

water more than clears it. It is better to ask just one question that is absolutely clear in

your mind, than several that are vague.

Next, Ask the Question

Now that you have your question, begin a game and then follow these steps:

1.  Select Oracle under Options to engage the oracle. If you do this during a game,

the "What is your question?" dialog will appear immediately. If you do this prior to

beginning, the dialog will appear as soon as  you begin a New Game.

2.  At the dialog box, type in your question for the oracle. Use the delete key, double

click on a word, or highlight several words (as you would with any standard word

processor) if you need to edit your question. If you want to think some more about your

question, select Cancel to close the dialog box without saving the question. 
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3.  When you are satisfied with your question, select OK to save your question and

close the dialog box. If you wish to change your question after selecting OK, you must

reselect Oracle under Options twice (the first time will deselect the oracle, the sec-

ond time will reselect it). Your question will reappear and you may change it as you

please.

4.  When you complete a 4-Way, an oracle augury appears in response to your question.

Read the text, then select OK to close the oracle augury dialog box and resume play-

ing. Follow steps 1 through 3 above to create another question any time before you

complete your next 4-Way.

A 4-Way produces one oracle reading only. You cannot undo your last move after

achieving a 4-Way and obtaining an oracle reading. The oracle is not available in the

computer play or Tournament modes. Try playing in the Cooperative mode to ask a
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question jointly with a friend; or in the Challenge Mode if you and another person are

looking for an amicable solution to a dispute.

If you complete a game without having achieved a 4-Way and, thus, haven't received

an oracle answer to your question, the "What is your question?" dialog will automati-

cally reappear with your unanswered question when you begin a new game. Simply

select OK if you still wish a response to that question.

Then, Interpret the Augury
When you complete a 4-Way, the oracle augury, or reading, appears. If necessary,

use the grabber hand with the mouse button down or the scroll bar to see all the text.

An augury is a sign, or indication–a way of discerning a course of action (or inaction)

by observing and interpreting. Ishidó's auguries are based on the ancient oracle known

as the I Ching, the Chinese Book of Changes. Ishidó arrives at a particular augury by

factoring the identities and locations of the five stones in the 4-Way together with the

precise moment (to 1/60th of a second) the 4-Way is created. 

The language of the auguries is symbol and metaphor. Any answer which responds lit-

erally to a question is not so rare as it is fortuitous. Expect to have to intuit the mes-

sage conveyed by the augury.

Sometimes auguries respond not to the question consciously asked, but to the hidden

and unspoken question that may really be confronting the questioner's subconscious.

Stay attuned to this possibility, use your intuition, and remain open to the possibility of

a surprisingly meaningful response.

Whether the auguries seem clear or confusing to you, keep in mind that the Oracle of

the Stones is not a fortune-telling device. It does not absolve the questioner of the

responsibility for making choices about the future. It does not determine or predict the

future. What the oracle can do is direct attention toward those inner choices that

remain unseen until the question is asked, and so aid the questioner in making deci-

sions that are pivotal in determining his or her future.
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Saving Auguries

You can save an individual oracle augury when you read it, or set up an option that

automatically saves all oracle readings.  

To save an individual oracle reading, follow these steps: 

1.  With the oracle reading dialog box still open, move the cursor to the top of the

screen, and select Save Stonecast... from the Options menu.

2.  In the “Save Oracle text in:” dialog box, select Default file to save the ora-

cle reading to the default Stonecast file. You can rename this file, and/or create new

ones as you desire.

Select Open File... to save the oracle reading to an existing file. A dialog box

appears with a scrollable list of files. Select the file or folder you want to contain the

oracle reading and then select Open. Select New File to save the oracle reading

to a new file. Type in the name of the new file at Create an Oracle save file:

and select Save.  Select Cancel to close any of the dialog boxes without making a

selection.

To automatically save all oracle readings, follow these steps:

1.  Select Oracle Preferences, under Options.
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Note: You can enter this menu even when the oracle augury dialog box is open.

2.  In the Oracle Preferences dialog box, select Automatically save the stonecast to

a text file. Ishidó automatically saves all oracle readings to the current file (named

Stonecasts above).

Select Open File to save the oracle reading to an existing file. A dialog box

appears, with a scrollable list of files. Find and select the file or folder you want to

contain the oracle reading and then select Open. Select Cancel to go back to the

Oracle Preferences dialog box without choosing a file.

Select New File in the Oracle Preferences dialog box to save the oracle reading

to a new file. Type in the name of the new file at Create an Oracle save file: and

select Save. Select Cancel to go back to the Oracle Preferences dialog box with-

out setting up a new file.

Ishidó's Document Editors feature lets you save oracle augury files in the application

format you specify. Specifying the application you want lets you open the augury text

file and the application at the same time. If you don't specify a format, Ishidó saves

augury files as unformatted text files that can be opened from within any MacWrite

compatible word processor. Follow these steps to select the word processing appli-

cation on your system:

1.  Select Preferences (not Oracle Preferences). At Document editors: select Text

files: by clicking within the rectangular box. A scrollable list box appears, showing the

current file or folder.

2.  Locate and select the word processing application you use and select Open. The

Document editors: dialog box appears with the name of your word processing

application after Text files:.

3. Select OK to close the Preferences: dialog box and return to Ishidó. Select Cancel

to close the dialog box without saving your text format choice.
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Specifying Gender

The oracle can respond to your questions using either male or female pronouns.

Indicate your preference by choosing it from the Oracle Preferences section under

the Options menu.
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The Hexagrams

The Oracle of the Stones uses the same synchronistic context and mathematical prob-

abilities to produce an augury as does the I Ching. Thus each Ishidó stonecast corre-

sponds precisely to an I Ching hexagram. If you are familiar with that ancient and

revered oracle, you might like to try consulting the I Ching employing the stones method

as an alternative to the customary coin or yarrow stalk methods. 

Follow these steps to see the I Ching hexagram resulting from your 4-Way.

1.  Select Oracle Preferences, under Options. 

Note: You can enter this menu even when the Oracle augury dialog box is open.

2.  Select Show an I Ching hexagram with the stonecast and then select

OK. The I Ching hexagram corresponding to your stonecast appears when you receive

an oracle reading.

3.  Select the option to show an I Ching hexagram with the stonecast again

and then select OK to make the hexagram disappear.  Select Cancel to close the

Oracle Preferences dialog box without saving your Oracle Preferences choice. You can

make this selection before the augury appears or while you are reading the augury.

Note: If you have chosen the Show an I Ching hexagram with the stonecast option,

then saving your stonecast to a text file will simultaneously record your hexagrams and

changing lines.

For a fascinating explanation of how the I Ching works, how hexagrams are formed, and an intro-

duction to the concept of synchronicity, please refer to C.J. Jung's foreword and Richard Wilhelm's

introduction to and translation of The I Ching, or Book of Changes (Princeton, N.J.: Bollingen Series

XIX, Princeton University Press, 1967).
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QUICK REFERENCE 

Keyboard Shortcuts

File Menu

≈-N Start a New game

≈-E End a game

≈-S Save a game

≈-O Open a game file

≈-Q Quit Ishidó

Oracle

≈-A Ask a question of the Oracle

Help Menu

≈-U Undo previous move

≈-M Show possible Moves

≈-H Get on-line Help

Graphics Editors

≈-Z Undo last function

≈-C Copy a stoneset or pattern to the clipboard

≈-V Paste a stoneset or pattern from the clipboard

≈-B Clear a stoneset or background

≈-E Edit a stone

≈-M Go to Mover (in color graphics editors only)

≈-N Create a New stoneset (in color graphics editors only)

≈-S Save a stoneset

ISHIDO™



80 MACPLAY™

=THE RISING SUN

=TORII

(Shinto, purification)

=THE ENDLESS KNOT

(Nade-Takara-Mushubi)

=BUDDHA

=SHOU (Long life)

=YIN/YANG (Taoism)

=JERA (Harvest)

=ALGIZ (Protection)

=DAGAZ (Breakthrough)

=PERTH (Initiation)

=WUNJO (Joy)

=SOWELU (Wholeness)

=NORTHWIND

=SOUTHWIND

=EASTWIND

=WESTWIND

=RED DRAGON

=GREEN DRAGON

=NORTHWIND

=SOUTHWIND

=EASTWIND

=WESTWIND

=RED DRAGON

=GREEN DRAGON
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=THUNDERBIRD

(Unlimited happiness)

=SUN (Light)

=BUTTERFLY

(Life everlasting)

=EYE (Wisdom)

=BUFFALO

(Great Provider)

=ARROWHEAD

(Alertness)

=SQUARE

(Logic, balance)

=CIRCLE

(Spiritual, wholeness)

=TRIANGLE

(Creative, change)

=DIAMOND

(Prosperity, The 4 Directions)

=HEART

(Love, compassion)

=PENTACLE

(Protection, excellence)

B/W; Color B/W; Color

=SHINING BRIGHT

(Sun & Moon)

=HEAVEN ABOVE

=THE PROVIDER

=SPIRIT

=GREAT SPIRIT

EVERYWHERE

=GREAT SPIRIT

ABOVE

B/W only

=THE SUN

=THE MOON

=URANUS

=VENUS

=MARS

=NEPTUNE

Color only 
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=PYRAMID

(Heavenly fire)

=COBRA

(Ascension)

=UTCHAT

(Health)

=HEHA

(Fox, Divine protection)

=HORUS

(Falcon, power)

=ANKH

(Life)

B/W only 

=OSTRICH FEATHER

(Truth, justice)

=SCARAB

(The sun)

=ANKH

(Life)

=FALCON

(the God Horus, power)

=UPLIFTED ARMS

(The soul)

=3 FOX SKINS

(Wealth)

Color only 
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About the Calligraphy

Page 1 . . . . . . . . . . Tao (Chinese-the Way)

Page 2 . . . . . . . . . . Ishidó (Japanese–The Way of Stones)

Page 3 . . . . . . . . . . Joy (Chinese)

Page 8 . . . . . . . . . . The Primal (Chinese)

Page 9 . . . . . . . . . . Dancing Energy (Chinese)

Page 11 . . . . . . . . . . Suchness (Japanese)

Page 18. . . . . . . . . . True Nature (Chinese)

Page 21. . . . . . . . . . Flowering (Chinese)

Page 27 . . . . . . . . . T'ai Chi & the Inner-World Arrangement of the Trigrams

Page 28 . . . . . . . . . Abundance (Chinese)

Page 34. . . . . . . . . . Zenith (Chinese)

Page 38 . . . . . . . . . The Eight Trigrams of the I Ching

Page 61 . . . . . . . . . . The Way Opens (Chinese)

Page 64 . . . . . . . . . Gain (Chinese)

Page 67 . . . . . . . . . Only This! (Japanese)

Page 69 . . . . . . . . . Power (Chinese)

Page 69 . . . . . . . . . The Heart of Truth (Chinese)

Page 70 . . . . . . . . . Integrity (Chinese)

Page 77 . . . . . . . . . Book of Changes (old style Chinese chara c te rs )

Page 78. . . . . . . . . . Advancing (Chinese)

Page 79 . . . . . . . . . Eternal (Chinese)
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Calligraphy and Picture Credits

Pages… 12, 70 Original Calligraphy by Eido Shimano-roshi

Cover The Mustard Seed Garden Manual of Chinese Painting 

Pages…19, 21 Translated and Edited by Mai-mai Sze

29, 34, 84 Princeton University Press, Princeton, New Jersey, 1963

Copyright © 1956 by the Bollingen Foundation, Inc.

Pages... 1, 87, 70 The Tao of Power 

by R.L. Wing

Doubleday/Dolphin, New York, N.Y.

Calligraphy by Tse Leong Toy

Copyright © 1986 by Immedia

Pages… 8, 19, The Illustrated I Ching 

22, 29, 34, 39, 62, by R.L. Wing

65, 70, 78, 79 Doubleday/Dolphin, New York, N.Y.

Calligraphy by Shun Yu

Copyright © 1982 by Immedia

Page 78 The I Ching

translated by Richard Wilhelm

Princeton University Press, Princeton, New Jersey, 1967

Calligraphy by Tung Tso-pin

Copyright © 1950 by the Bollingen Foundation, Inc.

Page 28 Chinese Symbolism and Art Motifs

by C.A.S. Williams

Charles E. Tuttle Company Inc.

Rutland, Vermont & Tokyo, Japan, 1974

Copyright © 1974 by Charles E. Tuttle Company, Inc.

Pages… 7,10, Quantum Soup

39, 68 by Chungliang Al Huang

E.P. Dutton, Inc. New York, N.Y. 1983

Calligraphy by Chungliang Al Huang

Copyright © 1983 by Chungliang Al Huang



CUSTOMER SERVICE
If you have any questions about this, or any other MacPlay product, you can reach our

Customer Service/Technical Support Group at:

M a c P l a y 17922 Fitch Avenue Irvine, CA 92714 Attn: Customer Service. Customer Service

is available 24 hours a day through our Automated Customer Service system, with a

Customer Service representative available during normal business hours at (714) 553-3530.

Please have your system information available, or better yet, try to be at your computer. The

more detailed information you can provide our support personnel, the better service we can

provide you.

MacPlay is a division of Interplay Productions. Most MacPlay support services are listed

under the parent company Interplay. If you have a modem, you can reach us at the follow-

ing:

Interplay BBS: We have a 24-hour, 7-day a week multiline BBS available for customer

questions, support and fixes. The number is 714-252-2822. Modem settings are 300-28.8k

Baud, V.32bis, V.42bis, 8-N-1. This is a free service. 

America Online: You can E-mail Interplay Customer Support at IPTECH. To reach our

Customer Support board in the Industry Connection, press CTRL-K for “Go To Keyword.”

Then type INTERPLAY in the Keyword window. In addition to reading and leaving messages,

you can download fixes and demos from the “Software Libraries.”

CompuServe: We are located in the Game Publishers B Forum, type GO GAMBPUB at

any “!” prompt. Then select “Section 5” for MacPlay. You can leave technical support ques-

tions there. You can also download fixes and demos from Library 5 in GAMBPUB. The best

place for game play hints about our games is in the GAMERS forum. If you are not already

a CompuServe member, you can call CompuServe toll-free at 1-800-524-3388 and ask

Representative #434 for a free introductory membership and a $15 usage credit. Besides

technical support for Macplay products, CompuServe offers many other services, including

communications, reference libraries, hardware and software support, travel, games and much

more. 

GEnie: We are located in the Games RoundTable by Scorpia, type M805;1 at any “?”

prompt. Then select “Category 13” for Interplay Productions. Fixes and demos are available

in the libraries. 

PRODIGY® Interactive Personal Service: You may send mail directly to us. Our ID is

“PLAY99B.”

Internet: You can reach MacPlay with “support@interplay.com”. Many MacPlay demos and

patches are available at Internet FTP sites.
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Limited Warranty

MacPlay Limited 90-Day Warranty

MacPlay warrants to the original consumer purchaser of this computer software product that the record-

ing medium on which the software programs are recorded will be free from defects in material and

workmanship for 90 days from the date of purchase. If the recording medium is found defective within

90 days of original purchase, MacPlay agrees to replace, free of charge, any product discovered to

be defective within such period upon receipt at its Factory Service Center of the product, postage paid,

with proof of date of purchase. This warranty is limited to the recording medium containing the software

program originally provided by MacPlay and is not applicable to normal wear and tear. This warran-

ty shall not be applicable and shall be void if the defect has arisen through abuse, mistreatment, or

neglect. Any implied warranties applicable to this product, including warranties of merchantability and

fitness for a particular purpose are disclaimed. MacPlay disclaims all responsibility for incidental or con-

sequential damages.

Some states do not allow limitations as to how long an implied warranty lasts and/or exclusions or limi-

tations of incidental or consequential damages so the above limitations and/or exclusions of liability may

not apply to you. This warranty gives you specific rights, and you may also have other rights which vary

from state to state.

Lifetime Warranty

If the recording medium should fail after the original 90-day warranty period has expired, you may

return the software program to MacPlay at the address noted below with a check or money order for

$5.00 (U.S. currency), which includes postage and handling, and MacPlay will mail a replacement to

you. To receive a replacement, you should enclose the defective medium (including the original product

label) in protective packaging accompanied by: (1) a $5.00 check, (2) a brief statement describing the

defect, and (3) your return address.If you have a problem with your software, you may wish to call us

first at (714) 553-3530. If your media is defective and a replacement is necessary, U.P.S. or registered

mail is recommended for returns. Please send the defective disk(s) only (not the box) with a description

of the problem and $5.00 to:

WARRANTY REPLACEMENTS 

MacPlay 17922 Fitch Ave., Irvine, CA 92714

System Upgrades

MacPlay has a system upgrade policy. At any time after purchasing any MacPlay product, you may

send us your original disks and a check for $15.00 (U.S. funds) and we will replace your disks with the

version for another computer system that you specify. (This price is subject to change).

Copying Prohibited

This software product and the manual are copyrighted and all rights are reserved by MacPlay and are

protected by the copyright laws that pertain to computer software. These disks are not copy-protect-

ed. This does not mean you may make unlimited copies. You can back up the disk for your own per-

sonal use, but it’s illegal to sell, give or otherwise distribute a copy to another person. 

NOTICE: MacPlay reserves the right to make modifications or improvements to the product described

in this manual at any time and without notice.
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